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Installation
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Before installing Norton AntiVirus, take a moment to 
review the system requirements. 

If you have difficulties installing Norton AntiVirus, see

“If your product won’t install” on page 38

System requirements
To use Norton AntiVirus, your computer must have one 
of the following Windows operating systems:

1 Windows 98/Me

1 Windows 2000

1 Windows XP
Home or Professional Editions

Installation of Norton AntiVirus is not supported on NEC 
PC98, Windows 95/NT 4.x, Macintosh, Linux, or server 
versions of Windows 2000/2003/XP computers.

w If you are planning to upgrade your Windows operating 
system from Windows 98/Me to Windows 2000/XP, you 
must uninstall Norton AntiVirus first and then reinstall 
after the upgrade is complete.
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Your computer must also meet the following minimum 
requirements.

w If you are installing on Windows 2000/XP, you must 
install with administrator privileges.

Operating system Requirements

Windows 98 1 133-MHz processor

1 64 MB of RAM

1 90 MB of available hard disk 
space

1 CD-ROM or DVD-ROM drive

1 VGA video

1 Internet Explorer 5.5 or later

Windows Me 1 150-MHz processor

1 64 MB of RAM

1 90 MB of available hard disk 
space

1 CD-ROM or DVD-ROM drive

1 VGA video

1 Internet Explorer 5.5 or later

Windows 2000 
Professional 
Edition 

1 133-MHz or higher processor 

1 64 MB of RAM

1 125 MB of available hard disk 
space

1 CD-ROM or DVD-ROM drive

1 Internet Explorer 5.5 or later

Windows XP 
Editions

1 300-MHz or higher processor 

1 128 MB of RAM

1 125 MB of available hard disk 
space

1 CD-ROM or DVD-ROM drive

1 Internet Explorer 6.0
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Supported email clients
Email scanning is supported for any POP3-compatible 
and SMTP-compatible email client including:

1 Microsoft Outlook Express version 4, 5, 6

1 Microsoft Outlook 97/98/2000/XP/2003

1 Netscape Messenger version 4, Netscape Mail version 
4, 6, 7

1 Eudora Light version 3, Eudora Pro version 4, Eudora 
5, Eudora 6.0, Eudora 6.0J

1 Pegasus 3

1 IncrediMail XE

1 Becky! Internet Mail 1.x, 2.0

1 AL-Mail32 1.11

1 Datula 1.x

1 PostPet 2.1, 2.06, 3.0

Unsupported email programs
Norton AntiVirus does not support the following email 
clients:

1 IMAP

1 AOL

1 POP3s with Secure Sockets Layer (SSL) 

1 Web-based email such as Hotmail and Yahoo! Mail

1 Lotus Notes

About encrypted email connections

Norton AntiVirus does not support email connections 
that use Secure Sockets Layer (SSL). SSL is a Netscape 
protocol that is designed to provide secure 
communications on the Internet. If you use an SSL 
connection, you are not protected by Norton AntiVirus.

To send email messages through SSL connections, turn 
off incoming and outgoing email protection in Norton 
AntiVirus.
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To send email messages through an SSL connection

1 In the main window, click Options.
If a menu appears, click Norton AntiVirus.

w If you set a password for Options, Norton AntiVirus 
asks you for the password before you can continue.

2 In the Options window, click Email.

3 Click OK.

4 Uncheck Scan incoming Email (recommended). 

5 Uncheck Scan outgoing Email (recommended).

6 Resend your email message.

Supported instant messenger programs 
The following instant messenger programs are 
supported:

1 AOL Instant Messenger, version 4.7 or later 

1 Yahoo! Messenger, version 5.0 or later

1 Windows Messenger, versions 4.7 or later

1 MSN Instant Messenger, versions 4.6, 4.7, 6.0 or 
later. Version 5.0 is not supported.

Before installation
See “Create 
Emergency Disks” 
on page 39.

Before you install Norton AntiVirus, you must prepare 
your computer. If your computer cannot start from a CD, 
create Emergency Disks.

Prepare your computer
If you have an earlier version of Norton AntiVirus, the 
new version automatically removes the earlier version. If 
your version is earlier than 2003, you must uninstall it 
before installing the new version. 

If you have Norton AntiVirus 2004, Norton AntiVirus 
2004 Professional, Norton AntiVirus 2003, or Norton 
AntiVirus 2003 Professional, you can transfer your 
existing option settings to the new version of the product.

Before you install Norton AntiVirus, do the following: 



Installation
Install Norton AntiVirus

9

1 If you have any other antivirus programs on your 
computer, you must uninstall them and restart your 
computer before installing Norton AntiVirus.
To uninstall other antivirus programs, see the user 
documentation that came with each program.

1 Close all other Windows programs before installing 
Norton AntiVirus, including those programs that are 
displayed in the Windows system tray.

Install Norton AntiVirus
You can install Norton AntiVirus from the CD or from the 
file that you downloaded.

To install Norton AntiVirus

See “If the opening 
screen does not 
appear” on 
page 10.

1 Do one of the following:
2 If you are installing from a CD, insert the CD into 

the CD-ROM drive.
2 If you downloaded your copy of Norton AntiVirus, 

double-click the file that you downloaded, and then 
click Install.

2 In the Norton AntiVirus 2005 Setup window, click 
Next to begin the installation. 

3 Read the License Agreement, and then click I accept 
the License Agreement.
If you decline, you cannot continue with the 
installation.

4 If prompted, type the product key. 

5 Click Next.

6 In the Pre-Install Scanner window, click Start Scan to 
scan your computer before installing Norton 
AntiVirus. If an infection is detected in an active 
program, Norton AntiVirus may shut it down. Save all 
your data before you begin.

7 Do one of the following:
2 If you want to end the scan, click Stop Scan.
2 If a virus is detected, for each file that you want to 

delete, click Delete.
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8 If you want to see the results of the scan, click View 
Details, and then OK to exit. 

9 Click Next.

10 Select a folder into which you want to install Norton 
AntiVirus.
If you are running Windows 98/98/Me, ensure the 
folder’s drive has 90 MB of available hard disk space. 
If you are installing on Windows 2000/XP, ensure you 
have 125 MB of available hard disk space. 

11 Click Next.
The Installation Progress window tracks the progress 
of the install, and displays the components that are 
necessary to run Norton AntiVirus.

See “After 
installation” on 
page 11.

12 Click Restart Windows Now (recommended) to 
complete the installation.

13 Click Finish.

If the opening screen does not appear
Sometimes a computer’s CD-ROM drive does not 
automatically run a CD.

To start the installation from the CD

1 On your desktop, double-click My Computer.

2 In the My Computer window, double-click the icon for 
your CD-ROM drive.

3 In the list of files, double-click Cdstart.exe.
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After installation
Should Norton AntiVirus prompt you to restart your 
computer, do so, and when Windows loads, the 
Configuration Wizard will appear. Otherwise, the 
Configuration Wizard appears after you install Norton 
AntiVirus.

Use the Configuration Wizard
The Configuration Wizard lets you activate and register 
Norton AntiVirus, launches LiveUpdate and a full system 
scan, and then schedules a weekly scan of your 
computer. You must be online to activate your product.

w If you choose not to register the software using the 
Configuration Wizard, or if registration fails for some 
reason, you can register by using the Product 
Registration option on the Help & Support menu in 
Norton AntiVirus or by visiting the Symantec Web site at 
www.symantec.com.

To use the Configuration Wizard

1 In the opening Configuration Wizard’s window, click 
Next.

2 In the Product Activation window, click Activate and 
register your product now (recommended).

3 Click Next.

4 In the first Registration window, in the drop-down list, 
select the Country/Region from which you are 
registering.

5 If you would like information from Symantec about 
Norton AntiVirus, check the method by which you 
want to receive that information, type your email 
address, phone number, and then click Next.

6 Check the box if you want to receive postal mail from 
Symantec.

7 Type your name and address, and then click Next.

8 In the Activation window, verify that you are 
connected to the Internet, and then click Next.
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9 In the Activation Complete window, click Print key 
to print a copy of the product key for your records, 
then click Next.

10 Review the subscription information, and then click 
Next.

11 If the Security window appears, Symantec 
recommends that you leave the default option 
checked and continue using Norton AntiVirus to 
protect your computer. 

12 Click Next. 

Norton AntiVirus automatically performs the 
following post-installation tasks:

13 Click Finish to launch the tasks.

Read the Readme file
The Readme file contains technical tips and information 
about product changes that occurred after this guide was 
printed. It is installed on your hard disk in the same 
location as the Norton AntiVirus product files. 

To read the Readme file

1 On the Windows taskbar, click Start > Programs > 
Norton AntiVirus 2005.

2 Click Readme.

Run LiveUpdate Ensures that you have the latest 
virus protection.

Scan for Viruses Performs a full system scan. 

Schedule weekly 
scans of local hard 
drives

Schedules a weekly scan of your 
local hard drives. You must have 
Microsoft Scheduler installed to 
use this option.
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For more information
The product documentation provides assistance for using 
Norton AntiVirus. You can find the information that you 
need on your computer and on the Web.

Use online Help
Help is available throughout your Symantec product. 
Help buttons and links to more information provide 
assistance that is specific to the task that you are 
completing. The Help menu provides a comprehensive 
guide to all of the product features and tasks that you can 
complete.

To use online Help 

1 At the top of the main window, click Help & Support 
> Norton AntiVirus Help.

2 In the Help window, in the left pane, select a tab. Your 
options are:

You can also print any topic in Help.

To print a topic in Help

1 In the Help window, click the Contents tab.

2 In the Contents list, select the topic that you want to 
print, and then click Print.

3 Select whether you want to print only the selected 
topic or the topic and all of the subtopics under it.

4 Click OK.

Contents Displays the Help by topic

Index Lists Help topics in alphabetical order 
by key word

Search Opens a search box in which you can 
type a word or phrase
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Window and dialog box Help

Window and dialog box Help provides information about 
the program. This type of Help is context-sensitive, 
meaning that it provides help for the dialog box or 
window that you are currently using.

To access window or dialog box Help

4 Do one of the following: 
2 In the window, click any Help link.
2 In the dialog box, select Help or More Info.

Access the User’s Guide PDF
The Norton AntiVirus User’s Guide is provided on the CD 
in PDF format. You must have Adobe Reader installed on 
your computer to read the PDF.

w If you purchased this product as an electronic download, 
Adobe Reader was not included. You must download it 
from the Adobe Web site.

To install Adobe Reader from the CD

1 Insert the CD into the CD-ROM drive.

2 Click Browse.

3 In the CD window, double-click the Manual folder.

4 If applicable, double-click the Adobe folder.

5 Double-click the program file.

6 Follow the on-screen instructions to select a folder for 
Adobe Reader and complete the installation.

Once you have installed Adobe Reader, you can read the 
PDF from the CD.

To read the User’s Guide PDF from the CD

1 Insert the CD into the CD-ROM drive.

2 Click Browse.

3 Double-click the Manual folder.

4 Double-click the PDF.

You can also copy a User’s Guide to your hard disk and 
read it from there. 
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To read a User’s Guide from your hard disk

1 Open the location into which you copied the PDF.

2 Double-click the PDF.

Symantec products on the Web
The Symantec Web site provides extensive information 
about all Symantec products. There are several ways to 
access the Symantec Web site.

To access the Web site from the Help menu

4 Select the solution that you want. Your options are:

Within your Symantec product, the Reports page 
contains a link to the Symantec online Virus 
Encyclopedia, as does the Windows Explorer toolbar.

To access the Web site from the Reports page

1 In the main window, under Norton AntiVirus, click 
Reports.

2 On the Reports page, click View Online Virus 
Encyclopedia.

Help and Support Takes you to the product support 
page of the Symantec Web site, 
from which you can access the 
knowledge bases and downloads 
for your product.

Symantec Security 
Response

Takes you to the Security Response 
page of the Symantec Web site, 
from which you can update your 
protection and read the latest 
information about antithreat 
technology.

More Symantec 
solutions

Takes you to the Symantec Store 
Web site, from which you can get 
product information on every 
Symantec product. 
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To access the Symantec Web site from Windows 
Explorer

1 Open Windows Explorer.

2 On the toolbar, on the Norton AntiVirus menu, click 
View Virus Encyclopedia.
This option connects you to the Symantec Security 
Response Web page, from which you can search for 
information on all types of viruses.

To access the Symantec Web site in your browser

4 On the Internet, go to www.symantec.com
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Use the information in this section to familiarize yourself 
with the product. 

This section includes the following information:

1 A list of all of the features in the product

1 A brief description of each feature

The feature summary can help you determine which 
feature to use to solve a problem. Read the feature 
descriptions to locate the correct component to use.

See “Use online 
Help” on page 13.

For more information on any of the features listed, see 
the online Help.
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Virus and threat protection features
Norton AntiVirus provides comprehensive virus 
prevention, threat detection, and repair software for your 
computer. It automatically detects and repairs known 
viruses. Norton AntiVirus detects viruses and other 
potential risks in instant messenger attachments as well 
as in email messages, Internet downloads, and other 
files. Easy updating of the virus definitions over the 
Internet keeps Norton AntiVirus prepared for the latest 
threats. 

Norton AntiVirus includes expanded threat detection of 
both known and emerging threats, such as spyware and 
other files that could put your computer at risk. Norton 
AntiVirus also scans files inside of compressed files. 

Norton AntiVirus continually monitors your computer 
and protects it from known and unknown threats using 
the following features:

Auto-Protect 1 Loads into memory when 
Windows starts, providing 
constant protection while you 
work.

1 Checks for viruses every time 
that you use software programs 
on your computer, insert floppy 
disks or other removable 
media, access the Internet, or 
use document files that you 
receive or create.

1 Monitors your computer for any 
unusual symptoms that may 
indicate an active threat. 

Automatic 
LiveUpdate

Updates your program and virus 
definitions automatically.

Compressed file 
protection

Detects and repairs viruses inside 
of compressed files.
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Email protection Protects incoming and outgoing 
email messages, preventing your 
computer and other computers 
from infection.

Instant messenger 
protection

Scans for and detects viruses in 
instant messenger attachments.

Bloodhound 
technology

Detects new and unknown viruses 
by analyzing an executable file’s 
structure, behavior, and other 
attributes such as programming 
logic, computer instructions, and 
any data that is contained in the 
file. 

Password 
protection

Protects Norton AntiVirus options 
from unauthorized changes.

Norton QuickScan Automatically runs once 
LiveUpdate updates your computer 
with program updates and virus 
definitions. Checks for infections 
that have processes running in 
memory and infections that are 
referenced by start-up folders and 
files.
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Norton Internet Worm Protection 
features

Internet Worm Protection prevents certain network 
worms and other Internet threats from attacking your 
computer. A worm is similar to a virus, but is a self-
contained program that can replicate itself over a 
computer network. Internet Worm Protection can detect 
a worm on the network before it copies itself onto your 
computer.

Internet Worm Protection uses the following methods to 
detect and handle network worms and Internet attacks:

Port blocking Monitors the behavior of outgoing 
network traffic to establish 
whether an incoming connection is 
suspicious.

Trojan horse 
detection

Detects if a connection is being 
attempted on a port that is 
commonly used by Trojan horse 
applications.

Auto blocking Blocks repeated Internet attacks. 
When Internet Worm Protection 
detects an attack, it automatically 
blocks any further communication 
from the attacker’s IP address for 
30 minutes. 

General rules Uses a set of rules to monitor and 
handle all traffic and applications 
on the network. If the default 
protection is not appropriate, you 
can add, modify, or remove rules 
in the rules wizard.

Traffic analysis Monitors and detects network 
traffic for malicious activity. It can 
block the traffic, log the event, and 
issue an alert.



Feature summary
Norton Internet Worm Protection features

21
Exploit detection Prevents another computer from 
exploiting bugs in your computer’s 
software. Worms use these bugs to 
transfer infected files onto your 
computer. 

Threat level Scans an application for known 
viruses, and determines whether a 
program is malicious.
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Advanced Utilities features
Norton Utilities keeps your computer working optimally 
by finding, solving, and preventing Windows and disk 
problems. The UnErase and Wipe Info tools are 
supported by Windows 98/Me/2000/XP and include the 
following features:

UnErase Wizard Locates and recovers files that are 
protected by Norton Protection or 
the Windows Recycle Bin. 

Norton Protection Adds extra data recovery protection 
to the Recycle Bin. When used in 
conjunction with UnErase Wizard, 
it provides a complete recovery 
system for all deleted or 
overwritten files.

Wipe Info Permanently removes unwanted 
files so that they never can be 
recovered by a file recovery 
program. It can also wipe the free 
space on your hard disk to ensure 
that previously deleted 
information is not left on your 
hard disk.
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This section contains information about starting your 
Symantec product and the features that are available in 
the main window. 

It is not usually necessary to open your Symantec 
product to benefit from the protection features that it 
provides. Automatic features that are set during 
installation provide you with basic protection.

Open your Symantec product to view status information, 
customize option settings, perform basic tasks, and 
temporarily disable automatic features.
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Start Norton AntiVirus
All of the program features can be accessed from the 
main window. In addition, some features can be accessed 
from the Windows Explorer toolbar, Windows system 
tray, or Windows shortcut menu.

Norton AntiVirus protects any computer on which it is 
installed. You do not have to start the program to be 
protected. 

To start Norton AntiVirus

4 Do one of the following:
2 On the Windows taskbar, click Start > Programs 

> Norton AntiVirus > Norton AntiVirus 2005.
2 On the Windows XP taskbar, click Start > All 

Programs > Norton AntiVirus > Norton 
AntiVirus 2005.

2 On the Windows desktop, double-click the Norton 
AntiVirus icon.

2 In the Windows system tray, double-click the 
Norton AntiVirus icon.
In Windows XP, the system tray is called the 
notification area.



Getting started
About the main window

25
About the main window
The main window lets you access program components, 
set options, and access online Help.

To explore the main window

1 On the left side of the main window, select the option 
that you want. Your options are:

Status View the system status of your Norton 
AntiVirus installation, your Security 
Scanning Features, and Norton 
AntiVirus Subscription settings.

Scan for Viruses Select where Norton AntiVirus scans 
for viruses on your computer.
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2 At the top of the main window, select the option that 
you want. Your options are:

Start Norton AntiVirus from the Windows Explorer 
toolbar

Norton AntiVirus adds a button and a menu to the 
Windows Explorer toolbar. 

To start Norton AntiVirus from the Windows Explorer 
toolbar

4 On the Windows Explorer toolbar, click the Norton 
AntiVirus icon.

When you first open Windows Explorer after installing 
Norton AntiVirus, you may not see the Norton AntiVirus 
button and menu. You might have to restart Windows 
before the toolbar button appears.

w You may not be able to access the Norton AntiVirus 
Windows Explorer menu, depending on your computer’s 
configuration. 

Reports View Quarantined items, an Online 
Virus Encyclopedia, and an Activity 
Log.

Advanced Tools Use Unerase Wizard or Wipe Info 
Wizard.  Unerase Wizard helps you 
recover deleted files from the 
Norton Protected Recycle Bin and 
the Windows Recycle bin. Wipe Info 
Wizard erases files or folders from 
your hard disk so that they cannot 
be recovered.

LiveUpdate Start LiveUpdate to update virus 
definitions and Norton AntiVirus.

Options Customize the general features of 
Norton AntiVirus.

Help & Support Access Help for Norton AntiVirus.
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To display the Norton AntiVirus button and menu

1 In Windows Explorer, on the View menu, click 
Toolbars > Norton AntiVirus.

2 Click the arrow to the right of the button to view your 
options.

Use the Windows shortcut menu
You can access Norton AntiVirus from the Windows 
shortcut menu. 

To use the Windows shortcut menu

4 Right-click a disk, folder, or file icon, and then select 
an available option. 

Start Norton AntiVirus from the DOS command 
line

If you are working in a DOS window (for example, writing 
a script or code), you can start Norton AntiVirus while 
still in DOS.

To start Norton AntiVirus from the DOS command line

1 In the DOS window, at the prompt, type CD 
C:\Program Files\Norton AntiVirus\ or the 
directory where Norton AntiVirus is located.

2 Press Enter.

3 At the prompt, type NAVW32

4 Press Enter.
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Activate your product
Product activation reduces software piracy and ensures 
that you have received genuine Symantec software.

If you did not activate your product when first prompted, 
you will receive an Activation Needed alert every day 
until you activate the product.

w You must activate your product within the time period 
specified by the alert or the product will stop working.

You can activate your product from the Activation 
Needed alert or from the Activation option on the Help 
menu. Activation should take just a few minutes.

To activate your product from the Activation Needed 
alert

1 In the alert, click Activate Now.

2 Click OK.

3 On the Activation screen, click Next.

4 On the Activation Successful screen, click Finish.

To activate your product from the Help menu

1 At the top of the main window, click Help and 
Support > Activation.

2 On the Activation screen, click Next.

3 On the Activation Successful screen, click Finish.

If you have problems activating
If you cannot connect to the Symantec servers to activate 
your product, first check to see if you have parental 
control software or an ISP that might be blocking the 
connection. If that doesn’t resolve the issue, you can 
activate by phone.

Check for connectivity blocking

A connectivity problem can occur if you are using 
parental control software or are using an ISP that 
provides parental controls. If you suspect that parental 
controls are blocking the connection, configure the 
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parental controls so that they do not block the activation 
procedure. You will need to log in to your parental control 
software as an administrator, or log in to the Internet 
through your ISP as an administrator, to change your 
configuration.

Activate by phone

If parental controls are not the problem, or if you cannot 
reconfigure your parental controls to resolve the issue, 
you can activate by phone.

To activate by phone

1 Disconnect from the Internet.

2 Attempt activation again. 

3 After the connection fails (which could take a minute 
or two), select Activate my software by phone, then 
click Next.

4 Follow the prompts provided.
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Turn off Auto-Protect temporarily
If you have not changed the default option settings, Auto-
Protect loads when you start your computer to guard 
against viruses, Trojan horses, worms, and other 
malicious threats. It checks programs for viruses as they 
are run and monitors your computer and removable 
media for any activity that might indicate the presence of 
a virus. When a virus or virus-like activity is detected, 
Auto-Protect alerts you.

In some cases, Auto-Protect may warn you about a virus-
like activity that you know is not the work of a virus. If 
you will be performing such an activity and want to avoid 
the warning, you can turn off Auto-Protect.

w If you have set a password for Options, Norton AntiVirus 
asks you for the password before you can view or change 
the settings.

To turn off Auto-Protect

1 In the main window, click Options.
If a menu appears, click Norton AntiVirus.

2 In the Options window, under System, click Auto-
Protect.

3 In the Auto-Protect pane, uncheck Enable Auto-
Protect.

4 In the Options popup window, select the period 
during which you want Auto-Protect turned off. 

To turn on Auto-Protect

1 In the main window, click Options.
If a menu appears, click Norton AntiVirus.

2 In the Options window, under System, click Auto-
Protect.

3 In the Auto-Protect pane, check Enable Auto-
Protect.

If the Norton AntiVirus icon is visible in the Windows 
system tray, you can use it to turn on and turn off Auto-
Protect.
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To turn on or turn off Auto-Protect using the Norton 
Antivirus icon in the Windows system tray 

4 In the Windows system tray, right-click the Norton 
AntiVirus icon, and then do one of the following:
2 Check Enable Auto-Protect to turn on Auto-

Protect.
2 Uncheck Enable Auto-Protect to turn off Auto-

Protect.
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If you have an emergency, read these sections to try to 
find the solution to your problem. 

Common problems include: 

1 Virus threats

1 Trouble restarting your computer 

1 Lost or missing files

1 Possible disk damage

w If you purchased this product to address any of the 
problems listed above, read these sections first. 
Immediate installation of the product may not always 
provide the best solution to your problem.
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What to do if a virus is found
w If after reviewing the information in this chapter, you 

have not resolved your problem, see “Frequently asked 
questions” on page 41.

Viruses can be found during a manual or scheduled scan 
or by Auto-Protect when you perform an action with an 
infected file. Threats and security risks can appear 
during an instant messenger session, when sending an 
email message, or during a manual or scheduled scan.

If Norton AntiVirus finds a virus or a file containing a 
virus or a potential security risk on your computer, there 
are several possible resolutions to the problem:

Resolution Action

Fix infection Removes the virus from the file or if the 
threat is a worm or Trojan horse, deletes 
the file. 

Quarantine 
infection

Makes the file inaccessible by any 
program other than a Symantec antivirus 
program. 

You cannot accidentally open the file and 
spread the virus, but you can still 
evaluate it for possible submission to 
Symantec. 

Delete 
infection

Removes the virus from your computer by 
deleting the file that contains the virus, 
worm, or Trojan horse. Delete should be 
used only if the file cannot be repaired or 
quarantined.

Manual 
Removal

Lists infections that Norton AntiVirus is 
unable to automatically remove. 
However, the Manual Removal window 
lets you launch the Symantec Web site for 
a tool or instructions to remove these 
infections.
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The online Help contains more information about this 
feature. See “Use online Help” on page 13.

If Norton AntiVirus cannot repair a file
One of the most common reasons that Norton AntiVirus 
cannot automatically repair an infected file is that you do 
not have the most up-to-date virus definitions. Before 
running LiveUpdate to update your virus definitions, 
ensure that QuickScan is turned on (it is turned on by 
default). After LiveUpdate updates your virus definitions, 
QuickScan automatically checks for infections that have 
processes running in memory or infections that are 
referenced by start-up files and folders.

If that does not work, read the information in the report 
window to identify the types of files that cannot be 
repaired, and then depending on the file type, take one of 
the following actions:

File type Action

Infected files with .exe, 
.doc, .dot, or .xls file 
name extensions (any file 
can be infected) 

Use the Repair Wizard to 
solve the problem.

For more information, see 
the online Help. See “Use 
online Help” on page 13.

Hard disk master boot 
record, boot record, or 
system files (such as IO.SYS 
or MSDOS.SYS) and floppy 
disk boot record and 
system files 

Replace using your 
operating system disks. 
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Look up viruses on the Symantec Web 
site

The Symantec Web site contains a complete list of all 
known viruses and related malicious code, along with 
descriptions. You must be connected to the Internet to 
look up viruses.

To look up viruses

1 On the left side of the main window, under Norton 
AntiVirus, click Reports.

2 In the Reports pane, click View Online Virus 
Encyclopedia.
The Symantec Web site opens in your Internet 
browser.

3 Use the links on the Web page to access the virus 
information that you want to view.
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If your computer won’t start 
If you have a virus or threat on your computer, you need 
to start the computer from an uninfected disk to remove 
the virus.

Scan for viruses using the CD
w You might need to change your computer’s BIOS Setup 

options to start from the CD-ROM drive. To do so, see the 
documentation that came with your computer.

To start from the CD and scan for viruses

1 Insert the CD into the CD-ROM drive.

2 Restart your computer.
Your computer displays the following information:
2 1 Boot from Hard Drive
2 2 Boot from CD-ROM

3 Press 2 Boot from CD-ROM to restart from the CD.
After the computer restarts, the Emergency program 
automatically begins to scan for and remove viruses. 

4 When Norton AntiVirus has finished scanning, 
remove the CD from your CD-ROM drive.

Suggestion For more information

Restart from the CD and 
scan your computer’s hard 
disk for viruses.

See “Scan for viruses using 
the CD” on page 37.



Responding to emergencies
If your product won’t install

38

If your product won’t install
w You must be running Windows in order to install your 

Symantec product.

If you try to install your product on a computer that has a 
virus and you choose not to run the Symantec Pre-Install 
Scanner, start over and run the Symantec Pre-Install 
Scanner as directed. 

If you cannot run the Norton AntiVirus Pre-Install 
Scanner, but you can connect to the Internet, go to
http://security.symantec.com and run virus detection 
from the Symantec Security Check Web site.

Once the virus has been repaired, delete the installation 
files that were left behind in the folder after you tried to 
install the first time. 

To delete remaining installation files

1 On the Windows taskbar, click Start > Run.

2 In the Run dialog box, type %TEMP%

3 Click OK.

4 Close the window.

5 After you delete the temporary files, begin installation 
again and run the Symantec Pre-Install Scanner to be 
sure that you have removed all of the viruses.
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Create Emergency Disks
Emergency Disks are used to start your computer in case 
of a problem. 

If your computer can start from a CD, you can use the 
product CD in place of Emergency Disks and do not need 
to create them. 

If you downloaded the software, the program for creating 
Emergency Disks (NED.exe) is included in the download. 
Locate the downloaded software on your hard disk, and 
then follow the instructions to create emergency disks, 
shown below.

If you cannot start your computer from a CD, you can use 
these instructions to create Emergency Disks on another 
computer or go to 
http://www.symantec.com/techsupp/ebd.html and 
download the Emergency Disk program. Follow the 
instructions included in the download to create the 
Emergency Disks.

Alternatively, you can download the Emergency Disk 
program from 
http://www.symantec.com/techsupp/ebd.html 

Follow the instructions that are included in the download 
to create the Emergency Disks.

w You will need several formatted 1.44-MB disks.

To create Emergency Disks

1 Insert the CD into the CD-ROM drive.

2 Click Browse CD.

3 Double-click the Support folder.

4 Double-click the Edisk folder.

5 Double-click NED.exe.

6 In the Welcome window, click OK.

7 Label the first disk as instructed, and then insert it 
into drive A. 

8 Click Yes.

9 Repeat steps 7 and 8 for the subsequent disks.

10 When the procedure is complete, click OK.
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11 Remove the final disk from drive A.

12 Test the first disk in the set to ensure that you can use 
it to restart your computer.

13 Store the Emergency Disk set in a safe place.

If you need to use Emergency Disks
You can use Emergency Disks to restart your computer 
and scan for viruses or run DOS-based recovery utilities.

To use Emergency Disks

1 Insert Emergency Disk 1 into drive A, and then 
restart your computer.
The Emergency program runs in DOS.

2 Select the program that you want to run.
For DOS program help, press the F1 key while you 
are running the program.

3 Follow the on-screen instructions for inserting and 
removing the Emergency Disks.

4 When the Emergency program is done, remove the 
Emergency Disk from drive A, and then restart your 
computer.



Frequently asked 
questions
 5
The information in this chapter will help you solve the 
most frequently encountered problems. 

Explore the Symantec service and 
support Web site

On the Symantec service and support Web site, you can 
find the latest protection and program updates, patches, 
online tutorials, Knowledge Base articles, and virus 
removal tools. 

To explore the Symantec service and support Web site

1 On the Internet, go to www.symantec.com/techsupp

2 Follow the links to the information that you want.

How can I find the version number?
You can check the version number of your product on 
your computer. 

To check the version number 

1 Start your product.

2 Click Help and Support.

3 On the Help menu, click About <your product 
name>.

4 If applicable, in the About dialog box, select your 
product name.
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If you need to uninstall
See “Use online 
Help” on page 13.

Instructions for uninstalling are available in the online 
Help.
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Troubleshoot virus and threat protection
Check here for possible solutions to issues that might 
arise with Norton AntiVirus.

How do I make Auto-Protect load when I start 
my computer?

If the Norton AntiVirus Auto-Protect icon is not visible on 
the lower-right corner of the Windows taskbar, Auto-
Protect is not loaded. Failure to load Auto-Protect may be 
due to one of the following situations:

You may have started Windows in safe mode. Windows 
restarts in safe mode if the previous shutdown did not 
complete successfully. For example, you may have 
turned off the power without choosing Shut Down on the 
Windows Start menu. 

To restart Windows

1 On the Windows taskbar, click Start > Shut Down.

2 In the Shut Down Windows dialog box, click Restart.

3 Click OK.

Norton AntiVirus may not be configured to start Auto-
Protect automatically.

To set Auto-Protect to start automatically

1 In the main window, click Options.
If a menu appears, click Norton AntiVirus.

2 In the Options window, under System, click Auto-
Protect.

3 Ensure that Start Auto-Protect when Windows starts 
up is checked.

Norton AntiVirus may not be configured to show the 
Auto-Protect icon in the Windows system tray.
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To show the Auto-Protect icon in the Windows system 
tray

1 In the main window, click Options.
If a menu appears, click Norton AntiVirus.

2 In the Options window, under System, click Auto-
Protect.

3 Ensure that Show the Auto-Protect icon in the 
Windows system tray is checked.

How do I stop a virus that continues to infect my 
files after I have scanned and removed the virus?

A virus may continue to infect files for several reasons.

The virus might be in a program file with an unusual 
extension for which Norton AntiVirus is not configured 
to search. 

To reset Norton AntiVirus scanning options

1 In the main window, click Options.
If a menu appears, click Norton AntiVirus.

2 In the Options window, under System, click Manual 
Scan.

3 Under Which file types to scan for viruses, click 
Comprehensive file scanning.

4 Click Manual Scan > Bloodhound.

5 Ensure that Enable Bloodhound heuristics is checked, 
and then click Highest level of protection.

6 Click OK.

7 Scan all of the disks that you use and repair all 
infected files.

The source of the infection could be a floppy disk. Scan 
all of the floppy disks that you use to ensure that they are 
free of viruses.

The virus might be remaining in memory after you 
remove it from the boot record. It then reinfects your boot 
record. If the problem is a Trojan horse or worm that was 
transmitted over a shared network drive, you must 
disconnect from the network or password protect the 
drive to let Norton AntiVirus delete the problem
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Why is Norton AntiVirus unable to repair my 
infected files?

If Norton AntiVirus cannot repair your infected files, you 
may not have the most current virus protection on your 
computer. Update your virus definitions regularly to 
protect your computer from the latest viruses. 

If, after using LiveUpdate, the virus cannot be removed, 
the file may be corrupted, or contain a new virus. Do one 
of the following:

1 Quarantine the file and submit it to Symantec. 

1 Replace the infected file with a clean copy, if one 
exists, and delete the infected file.

Why am I unable to receive email messages?
If you are using a firewall, it may block access to the 
Internet features of Norton AntiVirus and prevent receipt 
of Email messages.

You can temporarily turn off email protection and 
attempt to download your email messages again.

To temporarily turn off incoming email protection

1 In the main window, click Options.
If a menu appears, click Norton AntiVirus.

2 In the Options window, under Internet, click Email.

3 Uncheck Scan incoming Email.

4 Click OK.

5 Download your email messages.

6 Check Scan incoming Email to turn email protection 
back on.

Your email client may have timed out. Make sure that 
timeout protection is turned on. 

If you continue to experience problems downloading 
email messages, turn off email protection. 
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To turn off email protection

1 In the main window, click Options.
If a menu appears, click Norton AntiVirus.

2 In the Options window, under Internet, click Email.

3 Uncheck Scan incoming Email.

4 Uncheck Scan outgoing Email.

5 Click OK.

Why am I unable to send email messages?
If you get the message Norton AntiVirus was unable to 
send your email message because the connection to your 
email server was disconnected, your email client may be 
set to automatically disconnect after sending and 
receiving email messages. To resolve this issue, turn off 
this option within your email client. Consult your email 
client manual for instructions on how to do this. 

If you are using a firewall, it may block access to the 
Internet features of Norton AntiVirus. 

For Norton AntiVirus to scan outgoing email messages 
for viruses, it intercepts and scans the messages before 
they are sent to your email provider. To resolve this 
issue, turn off Norton AntiVirus outgoing email scanning.

To turn off outgoing email scanning

1 In the main window, click Options.
If a menu appears, click Norton AntiVirus.

2 In the Options window, under Internet, click Email.

3 Uncheck Scan outgoing Email.

4 Click OK.
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Troubleshoot LiveUpdate
Check here for possible solutions to issues that might 
arise with LiveUpdate.

What if I can’t use LiveUpdate?
When new updates become available, Symantec posts 
them on the Symantec Web site. If you can’t run 
LiveUpdate, you can obtain new updates from the 
Symantec Web site.

To obtain updates from the Symantec Web site

1 On the Internet, go to securityresponse.symantec.com

2 Follow the links to obtain the type of update that you 
need.

What if I run LiveUpdate on an internal network?
If you run LiveUpdate on a computer that is connected to 
a network that is behind a company firewall, your 
network administrator might set up an internal 
LiveUpdate server on the network. LiveUpdate should 
find this location automatically.

If you have trouble connecting to an internal LiveUpdate 
server, contact your network administrator.

Why is Automatic LiveUpdate having problems 
connecting?

Automatic LiveUpdate does not recognize proxy settings 
that are configured in the Internet Options Control Panel. 
To ensure that your proxy settings are used by Automatic 
LiveUpdate, you must configure them in the Symantec 
LiveUpdate Control Panel.
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Service and support 
solutions
The Service & Support Web site at 
http://service.symantec.com supports Symantec 
products. Customer Service helps with nontechnical 
issues such as orders, upgrades, replacements, and 
rebates. Technical Support helps with technical issues 
such as installing, configuring, or troubleshooting 
Symantec products.

Methods of technical support and customer service can 
vary by region. For information on support offerings in 
your region, check the appropriate Web site listed in the 
sections that follow.

If you received this product when you purchased your 
computer, your computer manufacturer may be 
responsible for providing your support.

Customer service
The Service & Support Web site at 
http://service.symantec.com tells you how to:

1 Subscribe to Symantec newsletters.

1 Locate resellers and consultants in your area.

1 Update your product registration.

1 Find out about orders, returns, or a rebate status.

1 Access Customer Service FAQs.

1 Post a question to a Customer Service representative.

1 Obtain product information, literature, or trialware.

For upgrade orders, visit the Symantec Store at: 
http://www.symantecstore.com
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Technical support
Symantec offers two technical support options for help 
with installing, configuring, or troubleshooting Symantec 
products:

1 Online Service and Support
Connect to the Symantec Service & Support Web site 
at http://service.symantec.com, select your user type, 
and then select your product and version. You can 
access hot topics, Knowledge Base articles, tutorials, 
contact options, and more. You can also post a 
question to an online Technical Support 
representative.

1 PriorityCare telephone support
This fee-based (in most areas) telephone support is 
available to all registered customers. Find the phone 
number for your product at the Service & Support 
Web site. You’ll be led through the online options 
first, and then to the telephone contact options.

Support for old and discontinued versions
When Symantec announces that a product will no longer 
be marketed or sold, telephone support is discontinued 
60 days later. Technical information may still be 
available through the Service & Support Web site at: 
http://service.symantec.com

Subscription policy
If your Symantec product includes virus, firewall, or Web 
content protection, you may be entitled to receive 
updates via LiveUpdate. Subscription length varies by 
Symantec product.

After your initial subscription ends, you must renew it 
before you can update your virus, firewall, or Web 
content protection. Without these updates, you will be 
vulnerable to attacks.

When you run LiveUpdate near the end of your 
subscription period, you are prompted to subscribe for a 
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nominal charge. Simply follow the instructions on the 
screen. 

Worldwide service and support
Technical support and customer service solutions vary 
by country. For Symantec and International Partner 
locations outside of the United States, contact one of the 
service and support offices listed below, or connect to 
http://service.symantec.com and select your region 
under Global Service and Support.
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Service and support offices

North America

Symantec Corporation
555 International Way
Springfield, OR 97477
U.S.A.

http://www.symantec.com/

Australia and New Zealand

Symantec Australia
Level 2, 1 Julius Avenue
North Ryde, NSW 2113
Sydney
Australia

http://www.symantec.com/region/reg_ap/
+61 (2) 8879-1000
Fax: +61 (2) 8879-1001

Europe, Middle East, and Africa

Symantec Authorized Service Center
Postbus 1029
3600 BA Maarssen
The Netherlands

http://www.symantec.com/region/reg_eu/
+353 (1) 811 8032

Latin America

Symantec Brasil
Market Place Tower
Av. Dr. Chucri Zaidan, 920
12° andar
São Paulo - SP
CEP: 04583-904
Brasil, SA

Portuguese: 
http://www.service.symantec.com/br
Spanish:
http://www.service.symantec.com/mx
Brazil: +55 (11) 5189-6300
Mexico: +52 55 5322 3681 (Mexico DF)
01 800 711 8443 (Interior)

July 20, 2004
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